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Weber

LABELS & LABELING SOLUTIONS

Scope

Welcome to the Legi for Windows 2.2 to Legitronic Labelirgft®are 3.6.2 Label Migration Guide. This
guide provides an overview of the process, and explaingd@earform the migration. This document is not
intended to teach the reader how to use the softwaregonsgdescribed in the process. Learning the
software is the sole responsibility of the user.

Introduction

As of this writing it has been 10 years since the ®3tbit version of Legitronic was released. The last
update to the 16 bit Legi for Windows 2.2.0 was Release 4, asdwwitten to address Y2K issues.
Hardware platforms, operating systems, and applicatiiware programs have changed many times in the
decade between LegiWin 2 and the current version of logugt Labeling Software. As such, some of the
technological chasms are too wide to cross. That hémgase, it is well worth weighing the effort spent
trying to bring your old labels forward into a new versafrsoftware against that of simply creating new
labels. Either way, you will spend considerable time effort on the project and you will still have tate

to use the new software.

Legi for Windows 2 Series labeling software came in sdvwegrsions from 2.0 to 2.2. These are 16 bit
applications developed for Windows for 3.11 to 9X. While [test version, 2.2, can be migrated directly
into Legitronic Labeling Software 3.6, (a 32 bit applicatwntten for Windows XP Professional,) the
earlier versions cannot. And again, a 2.2 label may natiumin 3.6.

Weber Marking Systems, Inc. Product Systems manageesaves the right to determine whether or not a
particular application is a good candidate for migration.

This is a lengthy, very detailed and highly technical proeesksit is entirely possible that the label format
file will be corrupted during this process or that the Wwill simply fail to migrate into the new software
This process cannot be performed quickly, or “walked throogkt the phone. You will have to touch each
label several times in both the old and the new soéwéou will need to be fluent in using MS Windows
XP Professional, including some of the more advancedresassuch as setting up ODBC driver links and
OLE DB driver links. You will need to have access to amdyws XP Professional login account with
administrative permissions over the system you béllworking with. You will also need to know how to
work with MS Access or the database program you wilidiag.

Additionally all versions of the Legi for Windows 2 Sexisoftware came with their own integrated Paradox
database utility. The Paradox tables created with LagWWindows 2.2 can be imported directly into MS
Access 2003, while the Paradox tables created with LegiMimdows 2.1 and earlier cannot. The 2.1
Paradox tables must be exported into and saved as aileéfore they can be opened in MS Access
2003.

Be sure to back up all your files before beginning any of tbegases outlined here.



How This Guide Is Organized

Section 1, Preparing the Legi for Windows 2.2 Labels
Section 2, Migrating the 2.2 Databases into MS Access 2003
Section 3, Installing Legitronic Labeling Software version 3.6
Section 4, Opening the 2.2 Labels in Legitronic 3.6.2

Appendix A, Migration Anomalies

Conventions Used in This Guide

Bold Italics

[Bold in square brackets]
<Bold> in pointed brackets
“Italics in quote$

Words > More wordsn Italics
separated by greater-than sign

Customer Support

Items, options, titles or locations on the computer
Buttons to click on

Computer keys
Things to type into the computer (without the quotes)

Navigation through menus or paths

For Legitronic technical support, call 847-364-8500 (ext. 773) betweehours of 8:08m and 4:30
PM, Monday through Friday. For hardware-related problems8dal364-8500 (ext. 776). There are
also white papers covering the most frequently asked que$EB&Gd about Legitronic software on
our web site. Just navigate an Internet browsewtow.webermarking.com/software_faqgs.htrihe
CD that your software came on contains a User’'s Manua



1. Preparing the Legi for Windows 2.2 Labels
In this section you will open each of your Legi for Wimdn2.2 labels in Legi for Windows 2.2. You
are looking for how the label has been designed to vesrkyell as to note certain label attributes such
as Tracking Serial Numberd $N, database table names and contents, paragraph fogmattech
graphic file locations. After you gather the informatiou need, and make any necessary changes,
you will save the label in Legi for Windows 2.2.
1.1.Make backup copies of all your labels and databases.
1.2.0pen Legi for Windows 2.2 and log in as you normally do.

1.3.Click [Label Design]. (Figure 1-1a, b)

1 Legi For Windows

?4' Label Design
File Edit AddField “iew Options Settings Help

File Applications Help

By
TE Label Design ? Security
1
A; Graphics \ 2 SN Tracking
g

Py

-
,:J Audit Trail ﬂConfiguration

I

Figure 1-1a, Figure 1-1 b

1.4.Click File > Open (Figure 1-2)

2 Label Design [_ (O]
Fil it AddField “iew Options Settings Help
...

Save..
Savess.,

Delete...

TiestBrint...
Tiest Bt tasadindmws Prnter

Eririt Latel Hemart..
Frinter Setup...

E xit

1 PACUSTOM ~2%ESTER ~143=<5RAW LEL

2PACUSTOM~2%WESTER™1435.LEL

APACUSTOM~2WWWESTER ~1\ T4RAW LEL

4 PACUSTOM~2WWESTER ™14 4. LBL

B PACUSTOM~2\RHEODYNEARHEODY 1. 2AEXTRAL™1ATEMPMLP.LEL
|

Figure 1-2
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1.5.Navigate to the location of your labels. (Figure 1-3 Arrdvesd 2)
1.6.Choose your first label. (Figure 1-3 Arrow 3)

1.7.Click [OK]. (Figure 1-3 Arrow 4)

File Hame Directones n Ok |

Ip_shox_Ibl c:\legiwin\labels

— Cancel |

injzmall.lbl o A -

leap_lbl S

Ip_shox.Ibl = 'fg;";" Network... |

mip. bl & labels

mip805.1bl A0

mmb. bl

mral00.1bl —

mvlabel_lbl

List Files of Type Drives

Label Files [*.Ibl) x| | = e winos v|< 1 S
Figure 1-3

1.8.Figure 1-4 shows the label that you opened.

B Label Design - LP_SBOX.LBL [_ O[]
File Edit AddField Yiew Options Seftings Help

|

_ TR XXXXXXXXX1
_ 1008000

Figure 1-4

LEAP SBOX
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1.9.Double click on a blank area of the label to operLthigel Settingsdialog box. (Figure 1-5)

1.10.Take note of the values that are in the options callédy Figure 1-5 Arrows 1 through 5. You
will need to know this information later.

1.11.Click [Options]. (Figure 1-5 Arrow 6)

Label Settings E
Label Descriﬂtiun Label Slu/\

Yv/ -l
F'nnter F'nnt Mh?E{

[Series 22 \( [Standard 300x300 =l

Label Print Lo Design Width Design Height
|1 500 II].5I]I]

Print Rotation “

No Rotation é

Qancel

Horz. Print Interval ¥ert. Print Interval
500 0.500

T

Horz. Count Unit of Measure

I :I © Inches Optmns |
€ Centimeters = =
Margin ¢ Points Printer Options... |

=

0.040  Dots
Label Print Log...

Figure 1-5

1.12.Click [Printer Options]. (Figure 1-6)

Label Settings | x|
Label Description Label Stock

@ | o
Printer Print Mode

series 22 =] |standard 300x300 =l

Label Print Lo Design Width Design Height
I 1.500 II].5I]I]
o Rotation
|No Rotation j|
. . Cancel
Horz. Print Interval Yert. Print Interval
|1.5I]I] II].EI]I] Colors. .
Horz. Count Unit of Measure 5
Il ﬂ # Inches e
" Centimeters

Margin " Points
II].I]4I]  Dots

Figure 1-6

Printer Options...

Label Print Log...
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1.13.Uncheck any choices selected_ebel Preview at Print Time(Figure 1-7)

1.14.Click [OK]. (Figure 1-7)

Label Settings
Label Description Label Stock

i | =
Printer Print Mode

Series 22 =]l [standard 300x300 = |
[x]

Label Print Lo

Label Options

¥ Display Graphic Fields: ok

Print Rotation | Show Fields as Transparent

Mo Rotation Cancel

¥ Dynamic Screen Updates

Horz. Print Int
I1 -500 Label Preview at Print Time
Horz. Count ™ Print Labels time

-

= ™ Print start time
Margin I Each gueried label
IU'MU " Each serial label
N
Figure 1-7

1.15.Take note of the values that are in the options callgedroFigure 1-8 Arrows 1-3. Your will
need to know this information later.

1.16.Click [OK]. (Figure 1-8 Arrow 4)

Label Settings x|

Label Description Label Stock

R | -l

{211 E] Printer Options

Serie:

Label rotation
|——“’"e' flone T
Printer speed

. Cancel
F;m::gf [incheS."Second]@
Mo

H

abel top Tear off

" Darkness
Horz. |—|] il Il]— il IT
1= b =
Margin  Points Printer Options...
0.040  Dots -

Label Print Log... |

Figure 1-8
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1.17.Click [OK]. (Figure 1-9) You are brought back to your label design.

Label Settings [ %]
Label Description Label Stock

Printer Print Mode

| series 22 = [standard 300x300 =

Lahel Print Lo Design Width Design Height
I |1.5I]I] II].5I]I]
[No Fotai
|No Rotation j|

) ) Cancel |
Horz. Print Interval Yert. Print Interval
|1.5I]I] II].EI]I] Colors... |
Horz. Count Unit of Measure .
|1 i’ & Inches Options... |

" Centimeters - -
Margin * Points Printer Options... |
II].I]4I] " Dots
Label Print Log... |

Figure 1-9

1.18.Click and drag your cursor from the upper left corner of éellto the lower right corner and
then release the mouse button. All the fields on thel kaill be selected (enclosed in thin-lined
boxes) and a large box will enclose them all. (Figu®)

2

?4‘ Label Design - LP_SBOX.LBL H=] E
File Edit AddField “iew Optons Seting: Help

= 1
in | | | | | | | | | | |

L TR0
| 1008000 |  LEAP SBOX

Figure 1-10

1.18.1.Look carefully at the fields in Figure 1-10. Notice how yedow field and the blue field

overlap in the green area. This is a problem that need® corrected. You will need to
correct this problem wherever you find it.
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1.18.2.Click outside the box, and all the fields will be destgldc(Figure 1-11)

TR XXXXXXXXX1
1008000 LEAP SBOX

Figure 1-11

1.18.3.Click on theTR. That field will be selected. (Figure 1-12)

File Edit AddField Wiew QOptions Settngs Help

i
1 1 1

_ \ﬁn XXXKJXXXX1
f 1008000 LEAP SBOX

Figure 1-12

1.18.4.Hover your cursor over a corner of the selection binte how the cursor changes from a
cross-hair to a double arrow. (Figure 1-13)

TR
1008

Figure 1-13
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1.18.5.Click and drag the cursor while it's a double arrow to resiedfield. (Figure 1-14)

— )

1'IXXXXXXXXX1

008000

Figure 1-14

1.18.6.Click off of the field to deselect it. (Figure 1-15)

i Label Design - LP_SBOX.LBL

Fie Edt AddField Yiew Options Settings

| TR XXXXXXXXX1
| 1008000 LEAP SBOX

Figure 1-15

1.18.7.Click and drag your cursor from the upper left corner ofidbel to the lower right corner
and then release the mouse button. All the fieldshenlgbel will be selected (enclosed in

thin-lined boxes) and a large box will enclose themNdite that the yellow and blue fields
are no longer overlapping. (Figure 1-16)

ELahel Design - LP_SBOX.LBL

IS [=] E3
File Edit AddField “iew Options Seftings Help
in | | |

il

| (TR
| 1008000 LEAP SBOX

Figure 1-16
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1.19.Click outside the box, and all the fields will be destddc(Figure 1-17)

i Label Design - LP_SBOX.LBL M=l
Fle Edi AddField Yiew Options Setings Help

il
| | | | | | | | I I

| TR XXXXXXXXX1
| 1008000 LEAP SBOX

Figure 1-17
1.20.Double-click on thél'R. (Figure 1-18a) That will open the field properties dialog.{Figure 1-
18b)
\ Field Name S

[=m] 0002 TR

ITRIXXXXXXXXX1

L ool " Top Justify

008000 LEAPSBOX | comemm, oy
" Horizontal Justify Vertical Just Cancel

" Left and right justify Expression...

¥ Display Field & Expression
¥ Print Field " Supplied Dat

osition{Size... |

Colors...

Design Orientation

[ Auto Wrap
Leftto Right ] | " Dynamic fit

Figure 1-18a Figure 1-18b

1.20.1.Note that theField Namein Figure 1-18b i©9002 There is nothing wrong with this kind
of name as long as you remember which field is which.r&emmend that you give fields
meaningful names. This will help you in the long run.

1.20.2.Look at the two options called out by Figure 1-18b Arrowlere are three valid choices
for migration. They are:

Neither option checked
Only Auto Wrapchecked
Only Dynamic fit checked

NOTE: If both Auto Wrap AND Dynamic fit are checkedJNCHECK Dynamic fit

1.20.3.Look at the two options called out by Figure 1-18b Arrow2e option checked at Arrow
2 will determine what the button called out by Arrow &slo

1.21.Click the button called out by Figure 1-18b Arrow 3.
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1.22.Look at the options called out by Figure 1-19 Arrow 1. Tla#sehe types of expressions that
can be used to create a field.

1.23.Make a note of what expression type the field(Bigure 1-19)
“In our example, Field 0002 is @onstantexpression. Constant means that the data is

always the same, or constant. When chosen, Legitop@as @&Constant Databox, called
out by Figure 1-19 Arrow 2, which contains the data fofigid.

- Text

Expreszsion - 0002 ’
1 - N
t Constant
" Reference Fields
" Database

" Text File
" Date or Time

Cancel |

[~ Auto Identical

Fill Charis

[~ Enable Padding

= String builder

Constant Data
TR =

Figure 1-19

Here are examples of the other Expression Types

3 ion - 0002 . . .
| — =l Here is aReference Field A Reference Field
Eria umber . . . . .
— Mo displays the data contained in the field it
@ Reference Fields =~ CYes ¢ Tracking Cancel | references. In this cageeld 0002 references
¢ Database i“— ; Field 0007
) 1 lnc[gmgnt I_Al.ltl:l Identical
#rzilz = [~ Auto Serial
" Date or Time N =
. I 1
" String builder P Fill Character EI Stant

[ Enable Padding - Al
¢ Pad Left & Pad Right '~ I BT

Beferenced Fieldg List of Fields

Add | |
Remove |
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Expresszion - 0002

" Constant
" Reference Fields
=D e

" Date or Tk

" String builder

E
o
= No
“es " Tracking Cancel |

™ Auto Identical

i“ 1 Increment
' [~ Auto Serial
Fill Character j 1

" Enable Padding il

©1Pad|Left; = 'Pad/Bight =

Qataha&(

Key Field in Label

Tahle... |

Return Field in Table

rguery/

0007 =l -
Expression - 0002
o
" Constant = No
" Reference Fields Yes " Tracking Cancel |
f"}li)atahas:: = I 1 Increment " Auto Identical
(ol | : SN

t""f]ate or 'i'ime

[~ Auto Serial

" String builder

[ -] Fit Character iI 1 start

" Enable Padding = il
£ Pad Left & Pad Right I Length

Text File ‘

Expression - 0002

" Constant
" Reference Fields
" Datahase
" Text File

ey
&= No
" Yes Hracking Cancel |

I~ &uto [dentical

i“ 1 Increment
= [T Auto Serial

¢ String builder

[ -] Fiti character il 1 |Start

I~ Enable Padding =
Pad|Left; *'Pad Bight =

Date or Time Scttin*

Current date MM{DD/YY

Current date MM{DDJ/YY
Current date DD/MM™Y
Current date Y {MM{DD

Here is aDatabase Field A Database Field
gets its data from a particular field in a
database  record, based on some
predetermined criteria. In this exampieeld
0002 will go to the table called out in
Database Tableand get whatever is called
for in the Return Field based on the record
that corresponds to the data contained in
Field 0007

Here is aText File Field. A Text File Field
displays the contents of the text file called
out in theText File field.

NOTE: Since the inception of the Unicode

Character Set, Text File fields are best
handled within the confines of a database
record. This is one situation where recreating
your labels from scratch is advisable. You
will spend more time and effort trying to

convert one of these fields than it would take
to make a new label.

Here is aTime or Date Field A Time or
Date Field displays the computer’s time or
date in various formats.
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: — = Lastly, here is &String Builder Field. This type of

Serial Numb
© Constant & No [ o | expression utilizes strings of Legitronic programming
" Reference Fields CYEes  Hracking Cancel . .
b A — l_—lm —— data expression commands and variables. Some of the
CTou e jl e expressions have changed in the decades since Legi for
ate or Time . . o
T [ ] it Chraracter 2“—1 Start Windows 2.2 was released._ If you are no_t famlllar with
...................................... FTe Pt f“WL . these commands, leave this alone. Legitronic Support
_\“Pad Lo e et ~ can help you to troubleshoot problems that might occur
a0 _ . . . . .
Expressioni™ after the migration to Legitronic Labeling Software 3.6.
format_date[get_current_date(),1) =]
Ll
Functions Fields
abo A o007 4] ile ame...l
ahs 0009 File Name
asc o014
auto_identical ~[|0015 ~| Ewvaluate |
abortf)

1.24.Now, we go back to oufield Properties, > Expressiodialog box. (Figure 1-20)

- Text

Expreszsion - 0002 ’
1 - N
t Constant
" Reference Fields
" Database

" Text File
" Date or Time

Cancel |

[~ Auto Identical

| Fi G 1|Start
" String builder Fill Charay t
[~ Enable Padding o
€ Bad|Left. & Pad Eigh Length
1

Constant Data
TR

Figure 1-20

1.25.See if the field contains@erial Numberoption as called out by Figure 1-20 Arrow 3. If it does,
be sure to note all the related settings.

1.26.Click [OK]. (Figure 1-20 Arrow 4)
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1.27.Double-click on the field to the right of Field 0002. (Figur21l) This opens the properties
dialog box forField 0007 (Figure 1-21b)

Text

Field Name

Data Result

& Left Justify

|>oooooooo<1

& Top Justify

" Right Justify " Battom Justify
" Horizontal Justify
¢ Left and right justify

Cancel |

TR XXXXXXXXX1
1008000 EAP SBOX
Figure 1-21a

¥ Display E
¥ Print Field

Design Orientation

Supplied... |
Font... |
Position!5ize... |

" Expression
& Supplied Data

Left to Right

-l

[~ Auto Wrap
[~ Dynamic fit

Figure 1-21b

1.28.Check the status of theuto Wrap, Dynamic fitcheck boxes for valid configurations, (Figure 1-

21b Arrow 1).

1.29.Note that on this field, th8upplied Dataoption is chosen, (Arrow 2). This in turn caused the
button called out by Figure 1-12b Arrow 3 to re8dpplied..

1.30.Click [Supplied...] (Figure 1-12b Arrow 3). This opens tBepplieddialog box.

Dty S
¥ Keyboard:
Remote Input

Options ‘q
I” Must enter data

¥ Print Labels
I” Print start

(Each serial label

Supplied Entry Time

I” Each queried label

" DDE
" Table Lookup

°

CHempte Groups
¥ Hemote 1
IV Bemote 2
I~ Remote 3
L} ‘ I-Hemnle 4

|

Data Type
umeric

Numeric
" Custom filter

W,

" Cancel

Operator Prompt

Default Data

Input Length
Mln Max

Custom Filter

R

o

Fle Lookup

N\
by | me |
A L4

Table Field

[

Table field to use as prompt

Figure 1-22

1.31.Note that thédata Sourcespecified iKeyboard.(Figure 1-22 Arrow 1)

1.32.Note that théSupplied Entry Timespecified isPrint Labels (Figure 1-22 Arrow 2)
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1.33.Note that theOperator Prompt (Figure 1-23 Arrow 3) and thBefault Data (Figure 1-23
Arrow 4) fields are blank, but could and indeed usually do, eodtta.

1.33.1.Let’s look at some of the other options on this feat(Fgure 1-23)

CHempte Groups
¥ Hemote 1
IV Bemote 2
I~ Remote 3
I-Hemnle 4
Supplied Entry Time

Dala vpe—————
¥ Print Labels umeric
I” Print start Cam:el
I” Each queried label Numeric

(Each serial label J " Custom filter

Data Source

W Keyboard: " DDE
! Remote Input " Table uokup
Options 4

I” Must enter data

Input Length

Operator Prompt : z Mln Max
Default Data A
(cm {

<
able Lookup A A Table Field
|_ {h > Tanle| H
A L4
Table field to use as prompt m

Figure 1-23

Custom Filter

1.33.1.1If Remote Inpu (Arrow A) is checked the options called out by Arrow Buld be
active and one or more would be checked.

1.33.1.2.f Table Lookup(Arrow a) is checked there would be entries in thiel$iealled out
by Arrows b, ¢ and d. You would need to take note of this ndmion.

1.34.Click [OK] until you get back to your label design.

1.35.Repeat all of the steps outlined in this section foryefield on every label.
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2. Migrating the 2.X Databases into MS Access 2003

2.1.Finding the database references

2.1.1.Log into Windows using an account with administrative peyés.

2.1.2.Log into Legi for Windows and open the first label in @asmode.

2.1.3.Look for any fields on the labels that access a @a&blhese can be fields that use
Supplied Data(Figure 2-1a) with &able Lookup(Figure 2-1b), &racking Serial Number
(Figure 2-1c), or a field with an expression typ@®atabase (Figure 2-1d)

- Data Source —Hemote Groups
Field Name Data Result I= Keybnard I=DDE I Hemote 1
[EnterLPN [oos0040 = Remnote Input ¥ Table Lookup I Remoti: 2
Options L ] I=Remote 3
= Left Justify (Ol Top Justify 0k |]7 Must enter data ‘ I= Hemote 4

" Right Justify

" Horizontal Justify
" Left and right justify

¥ Display Field
¥ Print Field

Design Orientation

" Bottom Justify
 Vertical Justify

K Font... |
Position/Size... |

" Expression
i Supplied Data

[~ Auto Wrap

Left to Right

j| ¥ Dynamic fit

Colors... |

 Supplied Entry Time
[ Print Labels

™ Print start

™ Each queried label
™ Each serial label

Data Typeg
 Alp i
" Alpha

Cancel
 Numeric

Custom filter
Input Length

‘ Min. Max.

Operator Prompt
IEnter LPN

Default Data

I[I[IEI]IMI]

Custom Filter

Table Lookup

I? 7
Table Field

Figure 2-1a

Table |

Table field to use as prompt

Figure 2-1b

Expression - EnterLPN

 Constant
" Reference Fields
& Database
"~ Text File

Serial Number
" No

-

Expression - EnterLPH

Serial Numher

Ok

Cancel |

™ Auto Identical
I~ Auto Serial

" Constant

(‘F{efcrcncc Flilds L

& Mo
" Yes

ﬂ I 1 Increment

" Tracking

Cancel |

[~ Auto Identical
[~ Auto Serial

" Date or Time

= String builder

[ -] Fincharacter z“ ! Start
" Enable Padding
I 1 Length

Th

" Date or

" String builder

Fill Character E“ 1 start

Database Table

Database Table

™ Query

Key Field in Label

& BPad LLefi. € Bad Right
e | |

Return Field in Table

|a01

|

Key Field in Label

Return Field in Table

AD1

| o

Figure 2-1c

Figure 2-1d

2.1.4.Write down the name of any databases or tables anddbafions
NOTE: The Tracking Serial Number Database is different agil deal with that separately.

2.1.5.Repeat steps 2.1.3 and 2.1.4 until all labels have beemnrec
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2.1.6.Exit Legi for Windows.
2.2.Creating the MS Access database
2.2.1.0pen MS Access 2003.

2.2.2.Click File > New (Figure 2-2a, b)

P Fle Edt Wew Inset Iools Window Help Type 3 question forhelp - Edt  View Insert Tools  Window  Help Type a question for help  +

: Getting Started - x L= Carl+ ‘  Getting Started - x
o : Get External Data 0 . n
rosoft Office Online = Microsoft Office Online
Close
= Connect to Microsoft Office = = Connect ta Mierosoft Office
onlne o s Gnline
= Get the latest news about using = Get the |stest nevss about using
Access Save As... Access
= Automatically update this st BTt = Actomatically update this list
from the vrel from the vel
— File Search. . —
Search for: AR FEY Search for:
Example: “Prink more than one copy” Print Previsv Example: "Prink more than ane copy”
Open Brint.. Chrkp e
BioFromTest.mob Send To BioFromTest.mdb
Project database,mdh 1 BioFromTest.mdh Project database. mob

Project datshase, mdb Project database, mob
EPTRACKING.mdh EFTRACKING.mdb
5 More... 3E:..\Project database.mdb 5 More...

4 EX\EPTracking|EPTRACKING.mdb

2 V4\...\Project database.mdb

[ create anewFle. [ Create anewfile..

JFEEi U A Ready oM 4

Figure 2-2a Figure 2-2b

2.2.3.ChooseBlank Databaserom theNew File list. (Figure 2-3)

151

‘fle Edt Vew Insert Took Window Help Type 3 question for help =
 New File - %

New

Blank database.

(2] Blank data access pags...
roject using existing data. ..
(2l Project using new data. ..
(21] From existing file...

Templates
Search online for:

%) Templates on Office Online

Ready [ 4

Figure 2-3

2.2.4.Browse to the location were you will keep your new dasab
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2.2.5.Change the default database name to a meaningful nagné_@belData”) in theFile New
Databasedialog box, (Figure 2-4a) and clicKifeate]. (Figure 2-4b)

¥ Microsoft Access 8 [=[ |3 O ¥ Miicrosoft Access N [ S
© Ele Edt  View Insert Tools window Help Type a questionforhelp = ' File Edt View Insert Tooks ‘Window Help Type a question for help
 New File v x  New File v %
File New Database File New Database
. Page.. age. ..
Save in: iy Documents -l@-32Q X . Save in: () My Documents -l @-3 Q@ X Cy P gd
ing data. . ing datz...
[ Alen cadsmy b b ey r. |5 tlen Academy Edrow mb e
|ileqi Secure Bl db2.mcb { |5 Legi Seaure B newsecurityz.mdb
My Recent | Manual Label Dispensers (2] db3.mdb My Recent | )Marwal Label Dispensers Newsecuntyzmdb
Dacuments iy Data Sources Eerew.mdb DOCUMENES 1y Data Sources
|-y Labels Elnewsecurity2.mdb |22 My Labels B security2t.mdb
)0y Music B newsecurity21.mdb :l (= My Music
Desktop lZ)My Pictures Bproduct Database. mdb & Orline Desktop My Pictures & Online

\My Quates
My Received Files
)snaalt Catalog
\)WinZip ¥7.0

|2 Zebra RF Server Solution

2] secwrity21.mdb

My Documents

My Computer

My Hetwork

Flaces

Save 85 type: [crosoft Office Access Database (*.mdb)

=l
=l

Create |

Cancel
|

Ready

Figure 2-4a

UM

My Cornputer

Py Metmork
Places

My Documenks

Filepame:  [Labelpata]

5|

Save as type! [Micrasoft Office Access Dakabase (*.mndb)

Il

Create |

Cancel
),

4

Ready

2.3.Importing the contents of the old databases

Figure 2-4b

UM

2.3.1.Click File > Get External Data > Importvhen theTablesscreen opens. (Figure 2-5a, b)

] Microsoft Access

Eile, it wisw Insert  Tools  Window  Help

i LabelData : Database (Access 2000 . -“mat)

Objects

Tables Creats table by using wizard

|

Cmrios Create table by ertering data

Forms
Reports
Pages
Macros

Modules

Groups

4] Favorites

Ready

Figure 2-5a

Type a question for help

=13l

Edit

New..

wigw  Insert

Qpen..

Tools
Chrk+nl

window  Help

Cr+o

Get External Data

[ ot

Close

Save

Save dis..

Back Up Datahase. .,
Export

File Search...

Page Setup. .

Prirk Preview

Brirt...

Send To

Database Properties
1 LabelData.mdb

2 dbé.mdb

3 BicFromTest.mdb

Ready.

41y, iProject database.

43 Link Tables,
chiks

ble: by using wizard
ble by entering data

Crk+P

mdb.

] Microsoft Access

Type a questi

=183l

jon for help
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2.3.2.Browse to the location of your existing databases andsshtheParadox (*.db)option in
theFile of type box (Figure 2-6)

Il

¢ File Edit Wew Insert Tools Window Help Type a question for help  +

| My Documents T @-@2@Q X Cy 3 - Toos-

|5 Alien Academy 2 drew.mdb
|5 Legi Secure B Labelpata.mdb
MyRetent |7 Manual Label Dispensers (2] newsecurityz mdb
(] My Data Sources [ newsecurityz1.mdb
I3)My Labels [ product Datahase.mdb
B security21 .mdb

Documents

File name: -

i Import

My Netwark. I 2
Places Files of type: IMicrosuFt Office Access (*,mdb;* ;*‘mda;*.mde;*‘adg [ cancel

Lokus 1-2-3D0S [F.wi*)
Lokus 1-2-3 (%, wk*
Outlaol

Texk Files (*.bxb;®.covi™® kabg™ asc)
Ready Windows SharePaint Services () NUM 4

Figure 2-6

2.3.3.Highlight the database you want to import and clickgort] . (Figure 2-7a) You will see
the Paradox database imported into your MS Access 2003adatas a table. (Figure 2-7b)

B ricosot ccess Il ~ioix]

Bl Edt Wew Insert Toos Window Help Typesquestionforhelp  « |G Rle Edt Wew Inset Tooks  Window Help Type & question for help =

Import

Look n: |25 Convert DB 2 MDB Sl@-3Q XL - Tools =

| %] FoR _DESC.DB

@ LabelData : Database {Access 2000 file format: P =[5
HOpen &4 Design ew | X 2y

Objects Create table in Design view

iy Recent
Documerts

Tabies ] Create table by using wizard

i reate table by entering data

Farms

Pages

Macras

=
=
Reports
b |
2
£

Madules

Graups
[ Favoriees

File pame: |

=] Tmpart |
Places Files of type: |pa,adUX (*.db) j Cancel

My Network

Ready UM | Rready HUM 4

Figure 2-7a Figure 2-7b

2.3.4.Repeat Steps 2.3.2 through 2.3.3 until all databases aret@apor

Page 20 of 53



2.4.Configuring the new database

2.4.1.Right click on the first table you imported in Steps 2.8/@ugh 2.3.4 , (Figure 2-8a) and
chooseDesign Viewfrom the menu. (Figure 2-8b)

B Microsoft Access

© Fle Edit View Insert

i LabelData : Databas

Took Window Help

e (Access 2000 file format)

EAen B2Deion tew | X |

eeeeee

aaaaa

e
|-l or_chs

Figure 2-8a

Type 2

P [ [ P i

questionfor help =

‘ File Edt View Insert Tooks Window Help

[ L abelData : Database (Access 2000 file format)
[Fopen Zpesign Tew | X 4p

Type a question for felp~ +

Objects

Forms
Reparts
¥4 Pages

- |

Create table by using wizard

Create table by entering data

Save ...
Export...
Send To

Addto Group

Create Shorteu. .

Figure 2-8b

2.4.2.Change thé®ata Typedo Text for all fields in the table. (Figure 2-9)

I Microsoft Access

© File Edit  Wiew

& FOR_CAS : Table
Field MName

Inseit  Tools  Window  Help

- HBISRYEERB|I- -

Destription

| § 5= 3 | FN QA @

=1olx|

Type aquestion for help  +

INGREDIENT L
INGREDIEMT 2
INGREDIEMT 3
INGREDIEMT 4
INGREDIEMT S
INGREDIEMT &

| DataType
Tt
Text

Text
Text
Text
Text
Text

Field Properties

Genersl | Loakup |
Fisld Sizs

Format

Input Mask

Yalidation Rule:
Walidation Text
Required

allow Zero Length
Indexed

Urizade Compression
IME Mods

IME Sentence Mode

Smatt Tags

No

Yes

es (Duplicates OK)
No

fo Contral

Nane

 field name can be up to 64 charactars long,
incluing spaces. Press F1 for help on field names.

be up to &

Design view. Fé = Switch panes. Fl = Help.

Figure 2-9

2.4.3.Click [Savd and close the table.

2.4.4.Repeat the previous step until all fields in all tablessatéo Text and have been saved.

NOTE: If you use the Tracking Serial Number feature, you negekrform Steps 2.3.2 and 2.3.3 again,
but in this case the Legi for Windows database tablansedtkserial.d and is located in th&:\LEGI
FOR WINDOWS\DATAfolder. You should not have to edit the design of thinet at all.
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2.5.Configuring the ODBC driver and defining a Data Source

2.5.1.Click Start > Control Panel > Administrative Tools > Data Sources (ODHREigure 2-10)

Administrative

Date and Time

=
)
‘u Automatic Updates
:',:i
2

i, Display
___j My Documents 3

i Folder Options
__| My Recent Documents » &) Fonts

_f} My Pictures || B Game Controllers
M Intel{R) Extreme araphics
5 w\f Favorites 3 E (R) P
o 4P Internst Options
]
5_! My Computer gw lava
"g My Network Places @@ Keyboard
: £y mail
l-' Contral Panel ) Mouse

e L Fhcmices Reem oo o d

Figure 2-10

@ Cormpanent Services
g Computer Managemenk

B Data Sources

E] Event Wiewer

@ Local Security Policy
B Microsoft \MET Framew:
e Microsoft NET Framew:
@ Performance

% Services

2.5.2.Select théSystem DSNab and clicHAdd] (Figure 2-11)

#71 ODBC Data Source Administrator

User DSN  System DSN | File DSN ] Driversl Tracing] Connection Pooling] About ]
System Data Sources”

Marne | Diriver

Herbal Microzoft Access Diiver [*.mdb)
Herbal Garden Microsoft Access Diiver [7.mdb)
Herbal Gardens Label  Micrazoft Access Diiver [* mdh)
Labelz Microzoft Access Diiver [*.mdb)
Leqi Microsoft Access Diver [*.mdb)
Serial Microzaft Access Diiver [* mdh)

Tracking Mumbers Microzoft Access Diiver [*.mdb)

on this machine, including MT services.

ﬁ Add...
Microsoft Excel Driver [“.xlz]

An0DBC Systemn data source stores information about how to connect to
the indicated data provider. & System data source iz visible to all users

Bemove

Lonfigure

o]

Cancel |

Help

Figure 2-11
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2.5.3.SelectMicrosoft Access Driveand click[Finish]. (Figure 2-12)

Create Mew Data Source fE

Select a driver for which pou want bo zet up a data source.

Mame | WA
Diriver do Microzoft Paradaos [(*.db ] 4
Diriver para o Microsoft Wisual FosPro E
IBM DB2 ODEC DRIVER M
Microsoft & T [ ] 4
Microzoft Access-Treiber [*. mdb) 4—
Microzoft dBase Driver [*.dbf) 4
icrozoft dBaze WFF Driver [*.dbf) E
Microsoft dB ase-Treiber [*.dbf]

Micrazoft Excel Driver [%.xls) 42
hdimrmmnl P Comml Temibme 1% 021 [
< | >

| Finish | Caneel
Figure 2-12

2.5.4.Enter aData Source Name(Figure 2-13) A Data Source NarfBSN is the name that
Legitronic uses to connect to your database.
Note: The description field is optional.

2.5.5.Click [Selec}. (Figure 2-13)

ODBC Microsoft Access Setup

[ata Source Mame: | CompanylLabels (] 4 |
Fi ""--;
D escription: g
Cancel
Database
Database: Help
Select... Create. .. Repair... | Compact... |
Adwvanced...

Syztem Databaze

* Mone

" Database:

[srsambosin.

Figure 2-13

i

Optiongs»

Page 23 of 53



2.5.6.Select the MS Access database you created and raahetData (Figure 2-14)

2.5.7.Click [OK] . (Figure 2-14)

!E}BC Microsoft Access Setup

Select Database

Dat| Database Mame Directories: + J

|LabeID ata.mdb chlegiwintdatabaze

o LabelData.mdbk‘ = ch ﬂ J
] (== Legiwi

Syl [ Read Only
[ Excluzive

Ligt Files of Type: Dirives:
Access Databases [".mﬂ | =R v Wetwark...

PO

Figure 2-14

2.5.8.Click [OK].(Figure 2-15)

0ODBC Microsoft Access Setup

D ata Source Mame:

Campar

Dezcription: |
Cancel
Database 4
Databasze; Ch\LegiwinDatabaze'LabelD atamdb Help
Select... | Create. .. | Fepair... Compact... |
Advanced...

System Databaze

* None

" Database:

g Optionzs >

Figure 2-15

i
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2.5.9.You should now be back at tl@DBC Data Source Administratoscreen. (Figure 2-16).
Click [OK].

I DDBC Data Source Administrator E r5_<|

User DSH  System DSH l File DSH ] Drivas] Tracing] Connection Pooling] About ]

System Data Sources:

Name | Driver ~ Add...
Palmd5 Microzoft Access Driver [*.mdb]
parkdod Microzoft Access Driver [*.mdb] Remove
Fa5 Microzoft Access Driver [*.mdb]
PedigreeSH Microzoft Access Driver [*.mdb] Configure...
Product Infa Microzoft Access Driver [*.mdb]
product labels % Microzoft Access Driver [*.mdb]

Microzoft Excel Driver [.xls)
RFID Microsoft Access Driver [*.mdb]

CompanyLabels Microzoft Access Driver [*.mdb]
CERIAI MIIWBER Wimrnenft Arrass Nrivar 5 mdk]

about how to connect to
source is visible to all users

An ODBC System data source stores infan
the indicated data provider. A Spste
on this machine, including NT s=ry

Cancel | Help

Figure 2-16
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3. Installing Legitronic Labeling Software version 3.6

What You Will Need
Windows XP Professional - Home editions are not supgorte
A license key (dongle)
Administrative privileges over the PC on which you'rstalling Legi
A database (MS*Access, SQL, etc) that uses currervatadinking tools, I.E. ODBC, OLE DB,

Microsoft Jet, ect
Only if your formats require database interaction

3.1.Install the Legitronic Labeling Software
3.1.1.Log into Windows using an account with administrative peyés.

3.1.2.Place the Legitronic Labeling Software CD in the CDNR@rive and let it start. Choose the
option to install as &ingle User Hardware KeyFigure 3-1)

1 Legitronic Labeling Software - InstallShield Wizard

License Enforcement

Select the type of license enforcement that applies ko your installation.

@ (%) Hardware Key (Single User)&

@ (O software Key (Singls User)

=)
et () Software Key (Mulitple Users,
4 ¥ (Mulitp 1

[ < Back " Next = ] [ Cancel

Figure 3-1
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3.1.3.After Legitronic is installed, go to the Windows Progr@moup that the installation created
and run the&Sentinel Installerprogram. (Figure 3-2a-b)

ii_% Sentinel System Driver 5.41.1 {32-bit) - Installshield Wizar:

’@ Accessories

) Datalogic Setup Type

4 @ Lotus Applications Choose the setup type that best suits your needs,

: ) Microsoft Cffice

@ Snaglt & Please select a setup bype.
We ki & Legitronic Labeling Software » E Administrator Em——
m Legitranic Labeling Software ' Complete
Jle Al progran features will be installed, (Requires the most disk
@ Space. )
" Custom

Choose which program features you want installed and where they
will be installed, Recommended for advanced users,

Installhiield

< Back I Next = I Cancel
Figure 3-2b

Figure 3-2a

3.2.Install New Printer Drivers

3.2.1.Log into Windows using an account with administrative peiyds.
3.2.2.0pen thePrinters and Faxesarea of Windows. (Figure 3-3)

3.2.3.Click theAdd a Printerlink. (Figure 3-3)

", Printers and Faxes A=
Fle Edit ‘iew Favorites Tools Help I
| Pseacn |7 roders [
Y8
L]

@

£ 2 @

hp Laserdet on LBLSVS3800 on MARS Microsoft Office
PRODSYS22 Document Image Writer

& & &

Weber Sato 84555 Weber Series 415

PDF995

&{

Veber Zebra 1055 Weber Zebra 10551 203

D
:
T £ & & «
“Weber Zebra 112 XL Weber Zebra 140 XiIll  weber Zebra 220 %Il weber Zebra PAXL10
Plus FRight 203 -

Figure 3-3
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3.2.4.Follow theAdd a Printer Wizardnstructions. (Figure 3-4)

Add Printer Wizard

Welcome to the Add Printer
@ wizard

Thiz wizard helps you install a printer or make printer
connections

O If you have a Plug and Play printer that connects

1 through a JSE port [or any other hot pluggable
port, such as IEEE 1394, infrared, and 2o on), you
do not heed to use this wizard. Click Cancel to
cloge the wizard, and then plug the printer's cable
into wour computer or paint the printer toward pour
computer's infrared port, and tur the printer on.
‘windows will automatically install the printer for you.

Tocontinue, click Next.

< Back I Mext » I Cancel
Figure 3-4

3.2.5.Choose thd_ocal Printer option, butUNCHECK Automatically detect and install my
Plug and Play printer (Figure 3-5)

Add Printer Wizard

Local or Metwork Printer
The wizard needs to know which type of printer to set up.

Select the option that describes the printer pou want to use:

& Local printer attached to this computer
Automatically detect and ingtall my Plug and Play printer

A network printer, or a printer attached to another compiter

i To set up a netwark. printer that is not attached to a print server,
\‘) uze the "Local printer”* option.

< Back I MNext > I Cancel
Figure 3-5
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3.2.6.Direct the printer to the port where it is installedg(i¥e 3-6)
NOTE: If using a networked printer contact your Network Adstirator.

Add Printer Wizard

Select a Printer Port
Computers communicate with printers through ports.

Select the port you want your printer to use. If the port is not listed, you can create a
riEw pork.

& Use the following port: [LPT1: [Recormmended Printer Part] j

LPT1: [Recommended Printer Port]
Mote: Most computers | LPT2: [Prirter Port]

The connector for this p| LPT3: e Port
Q L0 Port]
COM2: [Serial Part)

A COM3: (Serial Port]
\ - |COM4: [Serial Part)
= = FILE: [Print ta File)
C:ADocuments and Settingshall Users\Application Datg
Microzoft Document Imaging *writer Port: [Local Port)
" Create a new port: FDFS35PORT [Local Port]
Type of port: Local Part j

< Back I Mext » I Cancel |
Figure 3-6

3.2.7.Click [Have Disk] when the list of manufacturers and printers on litgtall Printer
Softwarewindow comes up. (Figure 3-7)

Add Printer Wizard

Install Printer 5oftware
The manufacturer and model determine which printer software to use.

3 \ Select the manufacturer and model of your printer. IF your printer came with an installation
disk, click Have Digk. If your printer is nat listed, consult your printer documentation for
col ible printer software.

b anufacturer |;|
Toshiba bra Z4h Flus 300
i =]
\U;”'?*S M Plus 203
e wieber Zebra 300
ang i -
e ‘wieber Zebra S0xilll
LI idakar Fabes QC8ALLL LI

This diiver is not digitally signed! Wwindows LI Have Disk... |

Tel me why driver signing is important

< Back I Mext » I Cancel |
Figure 3-7
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3.2.8.Click [Browse] on thelnstall from Disk window. (Figure 3-8)

Add Printer Wizard

Install Printer Software
The manufacturer and model determine which printer software to use,

Binstall rompisk x|
= Install From Disk =
= Insert the manufacturer's installation disk. and then
=_=.°’ make sure that the comect drive is selected below.

Copy manufacturer's files from:

< Back | [ent | Canel |

Figure 3-8

3.2.9.Browse to theC:\Program Files\Weber Marking Systems\Legitronic Labeling
Software\Printer Drivers\Windows-NT-2000-XP\Englidolder. (Figure 3-9)

21 x|
Laok in: | 123 English j Q-
i Fe iy Recent Documents
_}Webe Deskiop

(53 My Documents
5} by Cornputer
',;'g pdoxwing on ‘poseidan’ (&)
2 Custom_Projects on 'Demoroom20001
o Local Disk [C)
|5 Program Files

5 ‘weber Marking Systems

[ Legitranic
[ Printer Drivers

= Wino-NT-EDDD-XF' j Ten I
Filez of ty 5 g vl Cancel |
2 Legi on ‘pozeidon’ [G:)

2 epfon hera' [H:)
',;'g LabelSyzT ech on 'Demaroam2000° [
22 paulswd on 'hera' [P
22 ifid on 'hera' (A2
',;'g Technical Papers on ‘demoroom2000)
S paulswd on 'hera' (L)
2 Scanned Documents on ‘DiongsoshL
‘:._a My Hetwork, Places

Figure 3-9

File name

P
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3.2.10.Double-click on thaVeberNTfile. (Figure 3-10)

x|
Locate File ilﬁl

Look in: | B9 e j o j- o -

- WeherlT inf

AN

N

File name: — fu/eberNT inf = Open
[

Cancel |
A

| Filez of type: ISetupInformation [".irf]

Figure 3-10

3.2.11.Click [OK] on thelnstall from Disk window. (Figure 3-11)

Add Printer Wizard

Install Printer Software
The manufacturer and model determine which printer software to uze.

e-—l Install From Disk x|
= Inzert the manutacturer's installation disk., and then oK |
x make sure that the comect drive is selected below.

Cancel |

L &

Copy manufacturer's files from:

=]
C:\Program Files\weber Marking Systems\Legitronj Browse... I |

< Back | = | Cancel |

Figure 3-11
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3.2.12.Scroll through the list of printers and highlight the mddeanstall. (Figure 3-12)

3.2.13.Click [Next]. (Figure 3-12)
NOTE: If asked to replace or keep the existing driver, choosaaepl

Add Printer Wizard

Install Printer Software
The manufacturer and model determine which printer software to use.

JAN Select the manufacturer and model of your printer. |f your printer came with an installation
digk, click Hawve Disk. [f your printer iz not listed, consulk vour printer documentation for
compatible printer software.

Printers | ;I

‘wieber Zebra Z4M Pluz 300
‘wieber Zebra Z6M Plus 203
‘weber Zebra Z6M Pluz 280

‘wWindows pdate | Have Disk... |

< Back 1 Next » I Cancel |

Figure 3-12

This driver is not digitally si
Tell me why driver sigring is important

3.2.14.Continue through thAdd a Printer Wizard

3.2.15.ChooseNo to Default Printer, Share PrinterandPrint a Test Page(Figure 3-13a, b, ¢)

Add Printer Wizard Add Printer Wizard Add Printer Wizard
Mame Your Printer O Printer Sharing G Print Test Page y 0
“Pou must assign a name to this printer. t:-’ “You can share this printer with other network users Q” To corfim that the printer is installed propery, you can print a test page. Qol
Type & name for this printer. Because some programs do nat suppart printer and server If you want to share this printer, you must provide a share name. You can use the Do you wank to print & test pags?
name combinations of more than 31 characters, it is best to keep the name as shatt as suggested name or type a new one. The shars name wil be visble to other network
passible. usgers. Cifes

. & No
finter name: % Do not share this prirter
feber Zebia 90Xl

Share name:

D you want o use this printer as the defaulk printer?

 Yes

G'Nnh

< Back Next » Cancel ¢ Back I Newt> I Cancel < Back Hext » Cancel
Figure 3-13a Figure 3-13b Figure 3-13c
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3.2.16.Click [Finish] to complete thé&dd Printer Wizard (Figure 3-14)

Add Printer Wizard

Completing the Add Printer
Wizard

*r'ou have successfully completed the Add Printer ‘Wizard,
*Y'ou zpecified the following printer settings:

I ame: ‘wieber Zebra S0l
Share name:  <Mat Shared:

Part: COMT:

Model: ‘wieber Zebra S0l
Default: Mo

Test page: Mo

To cloze this wizard, click Finish. /

< Back I Firish I Cancel |
Figure 3-14

3.2.17.Click [Continue Anyway] to theWindows Logo Testingvarning.(Figure 3-15)

Hardware Installation

L ] ‘j The software you are installing for this hardware:
L

Printers

haz not pazzed Windows Logo testing to verify its compatibility
with ‘windows %P, Tell me why this testing iz important. ]

Continuing your installation of this software may impair
or destabilize the correct operation of your system
either immediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the hardware vendor for zoftware that has
assed Windows Logo testing.

Continue Anpway | STOP Installation I
Figure 3-15
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3.3.Configuring the printer driver
3.3.1.Right-click on the newly installed printer. (Figure 3-16)

3.3.2.ChoosePropertiesfrom the quick-pick menu. (Figure 3-16)

*®: Printers and Faxes

File Edit Wiew Favorites Tools Help

J J l.@ /I__\J Search 1= Folders v

Address Cq'a Printers and Faxes

Printer Tasks

)= jmt
[2] Add a prinksr - —
15 See what's printing

Select printing preferences

ﬁ;‘ Pause printing

& Share this printer Set as Defaulk Printer
Frinting Preferences. ..

Iﬂﬂ Rename this printer e

¥ Delete this printer Pause Printing

(& Set printer properties R Sharing...

Use Prinker Offline

Open

Other Pl kS Create Shortcut
eraces Microsoft XPS Docu
Wik Delete
Contral Panel ricer
E} Rename

2y, Seanners and Cameras

ﬂ My Docurnents \\ = %
Figure 3-16

3.3.3.Click on thePortstab. (Figure 3-17)

& Weber Zebra 90XITII Propetties x|
Device Settings | Fonts | Graphics I
General I Shating | Parts I Advanced | SecLirity

Location: I \

Comment:

tadel: “Wieber Zebra 90l

- Features 5\
Color: Mo Paper available:

Double-sided: Mo ;l

Staple: Unknown
Speed: Unknown

b arimum regolution: 300 dpi LI

Printing Preferences... | Print Test Page |

Ok I Cancel | Apply |
Figure 3-17
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3.3.4.Uncheckthe Enable Bidirectional Supporbption (near the lower left). (Figure 3-18)

& weber Zebra 90XIIII Properties 2%

Device Settings | Fants | Graphics
General I Sharing Ports | Advanced I Securnty

jAN

E:% Wieber Zebra 901l

Frint ta the following port(z). Documents will print to the first free
checked port,

Port | Drescription | Frinter | -
LI LPTT:  Printer Port
O P12 Printer Part
O LPT2:  Printer Part
O comz Serial Part
O coM3: Serial Part
O comM4: Serial Part

Add Port... | Delete Port | Configure Paort... |

¥ Enahble bidirectional support
[” Enable printer pooling

QK. I Cancel | Apply
Figure 3-18

NOTE: If you need to make changes to your port settings fickfigure Port]. (Figure 3-19a, b) Ask
your IS department if such changes are needed. (The remaaeh COM1 settings are shown)

& weber Zebra 90XIIII Properties 2l 2 weber Zebra 90XIIII Pr 2]
Device Settings | Fonts | Graphics | Device Settings | Fonts | Graphics |
General I Sharing Ports | Advanced | Security General I Sharing Ports | Advanced | Security

.

Port Settings | B

-
@ ‘wieber Zebra 90illl

Print ta the following port(s]. Documents will print ta the first free
checked port.

.
f
F
c
Part I Description | Printer - |

Data bits: |5 'I
Parity: |None 'I
Stop bits: [1 vl
Add Part.. Delete Part | Configure Part... |
I™ Enable bidirectional support I R >on / Xaff hd
™ Enable printer poling Ll
/ Restore Defauls_|

) = ]Tl Cancel || iyl |-
Figure 3-19a Figure 3-19b

Bits per second
L LPT1:  Printer Part "

O LPT2  Printer Port
O LPT3:  Printer Port
O comMz: Serial Port
O COM3: Serial Port
O comM4: Serial Port
COM1: Serial Port ‘wieber Zebra 30xilll =l

0K | Cancal | pply
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3.3.5.Click on theDevice Settingsab. (Figure 3-20)

Device Settings | Fants | Graphics
General I Sharing Parts | Advanced I Securty

S\
@ ‘wieber Zebra SOl

Frint ta the following part(z). Documents W print ta the first free
checked part.

Fart I Diezcription | Printsr I -
L LPTT:  Printer Part
O LPTZ:  Printer Part
O LPT2: Printer Part
O comz: Seral Port |-
Ul COM3: Serial Port
Ul COM4: Serial Port
COMI: Serial Part Wieher Zebra 906l hd|

Add Port.... Delete Port Configure Part... |

[ Enshlz bidirectional support
™ Enable printer pooling

Cloze | LCance! | Aipply

Figure 3-20

3.3.6.Click [Properties] on theSetup Label Sizeption. (Figure 3-21)

& weber Zebra 90XIlII Properties d |

General I Sharing I Ports I Advanced | Security I
Device Settings I Forits | Graphics

Weber Zebra 90XIII Device Settings
Properties. ..

Setup Label size...
- Cutter: Cutter not installed
. Memory module For templates: Memory module B

Cloze I Cancel | Apply
Figure 3-21
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3.3.7.Change the label settings from the default values t@gong larger than your largest label,
(Figure 22a, b) and cliciJK].

NOTE: If your largest label’s size is less than or equah&default values, skip this step.

21 21
| |
Ia.uuu Width & Inches |2u.uuu Width & Inches
" Millimeters

 Millimeters

Is_uuu Height  Dots Izu.uuu Height ® D
Cancel | 0K Cancel

Close | Cancel Apply Close | Cance! | Apply |

Figure 3-22a Figure 3-22b

3.3.8.Click [Close]to finish setting up your printer. (Figure 3-23)

& weber Zebra 90XilII Properties 2lx|
General | Sharing | Parts I Advanced I Securiy I
Device Settings | Fonts I Graphics

Cutter: Cutker not installed

Memory module For templates: Memory module B

Cloze I Cancel | Apply
Figure 23

Your Legitronic Labeling Software is installed and retmyse.
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4. Opening the Legitronic for Windows 2.2 Labels in Legitronic
Labeling Software version 3.6

4.1.Start the Legitronic Labeling Software.

4.1.1.Click Start > All Programs >Weber Marking Systems > Legitronic LabeBajtware >
Legitronic Labeling SoftwajgFigure 4-1)

»

Microsoft Offi Lotus Applications

@ Micrasoft OFfi Microsaft Office
Mebwork Associstes
Snaglt &

3
D »
3

i 3

3" Notepad Software395 2
3
3
3

@ Microsoft Offi
es

& Snaglt 8 Startup
B Legitronic Labeling Softwar

7fl Adobe Reader 7.0
@ Inkernet Explorer
& Iitiator Control Panel 1.1.8.16

44 windows Defender
@ ‘Windows Media Player

Log Off @ Shut Down
o start J @ j &) jg J @Migrating Label Formats ... I
Figure 4-1

4.1.2.Key in theLogin Name“webef and Login Password'legi” and click [OK] .
Tracking Serial Numbers
Tracking Serial Numbers are serial numbers that arengaveame and tracked by Legitronic. When a
label includes a tracking serial number field, the ihksue of that field is obtained from the Tracking
Serial Number table of your database from Section 2. \Wheetabel print job is submitted, the next serial
number to be used is stored in the Tracking Serial Nutabés.

When a label includes a regular serial number field, degs not keep track of the next serial number to
be used. Each time the label is printed, the serial rubvgins at the specified start point.
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4.2.Configuring Legitronic for Serial Number Tracking

4.2.1.Click File > Configuration TheConfiguration dialog box opens. (Figure 4-2)

it Legitronic Labeling Software 3.6.2

File wd Tools  ‘Window Help
ey CIr [+ T

Cpen Label for Design. .. Ciri+D
pen Archive Label for Design ~
pen Label for Printing. .. Cirl+0

(==

+l

Cil+5

Cirl+H

Configuratian...

Figure 4-2

4.2.2.Click the System Tabletab. (Figure 4-3)
4.2.3.SelectTracking Serial Numberfrom theTable Typedrop-down list. (Figure 4-3)

Configuration

Options ] File Locations l Remot=Mipt  System Tables l

Table Type
|T|ac:king Seral Mumber Log -

Settings

o Database
Provider: | Providers

Data Source: |

Table Name:

Figure 4-3
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4.2.4.Click [Database Providers]to setup a connection to the Tracking Serial Number Batb
(Figure 4-4)

Configuration

Options ] File Locations l Remote Input  System Tables

Table Type

|T|ac:king Seral Mumber lLog =

Settings

Provider: |

Data Source: |

Table Name: |

Figure 4-4

4.2.5.ChooseMicrosoft OLE DB Provider for ODBC Driverdrom the list on thdrovider tab,
then click Next >>]. (Figure 4-5)

Y Data Link Properties [X|

ection ] Advanced ] All ]

Frovider

OLE DB Provider(s]
MediaCatalogDB OLE DB Pravider
MediaCatalogtdergedDB OLE DB Provider
MediaCatalogw/ebDB OLE DB Provider
Microsoft Jet 4.00LE DB Provider

Microzoft OLE DB Provider For Data Mining Serviges
Micrazoft OLE DB Provider for Indexing Servic!
Microzoft OLE DB Provider for Internet Publishi
Microzoft OLE DB Provider for ODEC Drivers

Microzoft OLE DB Provider for OLAP Services 8.0
Microzoft OLE DB Provider for Oracle

Microzoft OLE DB Provider for Outlook. Search
Microzoft OLE DB Provider for SOL Server
Microzoft OLE DB Simple Provider
MSDataShape

OLE DB Provider for Microsaft Directory Services

Mest x>

’Tl Cancel | Help |
Figure 4-5
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B Data Link Properties
Provider Connection IAdvanced] A

Specify the following to connect to ODBC data:
1. Specify the source of data:
& Use data source name
| 4
ass
RFID

LI Refresh |
C &

SERIAL NUMBER
sernialnumber
2 Entel SHEATHING
: Slap n Ship
§ TableDump
TAGS

=

P4 tkserial
Visio Database Samples
weclabels

< |

weber
3. Entet WEBER DATA

I |

Test Connection

3

4.2.7.Click [Test Connectiorj and then QK]. (Figure 4-6b)

3 Data Link Properties

Provider Connection IAdvancedI All

1. Specify the source of data:
& Use data source name

4.2.6.Use thedata source namgou created in step 2.22. (Figure 4-6a)

Specify the following to connect to ODBC data:

|CompanyLabels
" Use connection string

® Microsoft Data Link

3. Enter the initial catalog to use:

l] Refresh

3

A Y |

ﬂ Test Connection

Help

o]

Cancel l

| ok |

Cancel | Help

Figure 4-6a

4.2.8.Click [OK]. (Figure 4-7)

B Data Link Properties

Frovider Cornectio

Specify the following to connect to ODEC data:
1. Specify the source of data:
@ Use data source name

Figure 4-6b

E3

n | Advanced| a1 |

|CumpanyLabeIs

" |Use connection sting
Connection sting:

LI Refresh

2. Enter information ta log on tathe server

Bild...

User name: I

Password: I

3 Enter the initial

™ Blank password

I~ &llow, ~aving password

catalog to use:

Test Connection

Help |

oK | Cancel |

Figure 4-7
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Configuration [z‘

Dptions | File Locations | Remote Input  System Tables l

Table Type
ITracking Serial Log LI
 Settings
Provider  [MSDASAL P |
Data Source: lCompanyLabeIs

CHEMMAIN

CHEMMAIN
CUSTLBLS
EXPOSURE
ITEMLIST
LABELS
MEDICAL
Namplat

Table Name:

WARNING

Figure 4-8a

4.3.0pening the Label

## Legitronic Labeling Software 3.6.2
N Edit ¥iew Field Tools Window Help

4.2.9.Selecttkserial, (Figure 4.8a) and then cliclOK]. (Figure 4-8b)

Configuration

Options | File Locations | Remote Input  System Tables |

Table Type
ITracking Serial Log ;I
 Settings
Provider. [MSDASGL s |
Data Source: ICompanyLabels

Table Name:  |[RS=E] LI
Clear I
0K N Cancel | Apply | Help I
A

Figure 4-8b

4.3.1.Click File > Open Label for Design(Figure 4-9)

Open Label F 0

Open Archive Label For Design
©Open Label for Printing. .. CtrG
Close

Save Ctrs
Save As...
Archive CtrHH

Configuration. ..

Prinker Setup...
Test Print... CirP
Print Label Report, ..

1 CiiLabels 3621Test 124.1bl

2 CiiLabels 3621154.1bl
3154100

4 1\LABELS\RFID}assembly. bl

Exit

Open an existing label for design [

| bumow | 4

Figure 4-9
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4.3.2.Browse to and highlight the label you want to import elick [Open]. (Figure 4-10a,

Open Label for, Design

Open Label for Design

Look in: [ () Labels - & ®E ek E Look irc | £ Labels & @ ek B-
) % '[‘:;;f;:”' BETIETS [o— Hhza bl 2 (20,500 [ dpLoob bl [fitenpcE b [Hzam
- &) My Documents [Btempdenz.bl [0 _Smtor Bl err [ tempdemz bl
My Recent 3 My Computer [Eitempdema.bl MyRecent 750 Sem [ tempdemo. bl
Documents i Documents |\ gay MPH B tempht bl
— e Local Disk [C:] tempht. bl — N, o
@ 1) Legwin HTemplb\‘\bl @ Do m“‘imﬁp‘at-lt Type: Legitranic Label
- [~} templrg2. bl D) Archives Mperkml.lhl Date Modified: 10/13/2008 12:59 PM
Desktop 2, DVDACDR Dive (D] emplg bl Desklon  |5yEwtra laels [liFionn | Sz 6,59 KB
N S8 Epg on ‘Dsirs' [5) mTempnp.Ibl . I)5erialTest MPR.IhI MTempnp.lhl
) # Customer Label Projects on ‘Poseidon'Frod-5 Mtasum i 76 Lt Bl rErRINT.LEL mt.est,lhl
L Z# Leaionic Support Resources on 'Poseidon'F Mt\mC_SN.Ih\ My Documents FTEST Jol mt'mc_SN“b‘
My Documents % LeqidZ on Poseidon’ (K] mnmcez.lb\ etialz. bl mtimcaz\bl
) # Leai on Poseidon’ (L) MTMP TITHI] ERIAL.LEL MTMP_TITN.IbI
g, 52 ProdSys on Poseidon’ [P2) mmm’suhl gj eriallg. bl %TMtest.lbl
g paulewd on hera' (L] TR My Computer PHT.Ibl TRIbl
My Compulter | &4 My Network Places %Xm i [ copy of BAG 80 LeL M rempeez. bl [ b0 bl
|55 Desktop Labels ' ¢ ] >
] Lo ' 3 < —
Frogram Files  File name: I d Tpen I Progiam Files  File name: Ilp_sbax bl j l&l
i : B - Cancel
Flesoitpe  [LabelFles (b0 3] Corcal | Fiesoftype: Label Fles (1) =] tened |

Figure 4-10a

Figure 4-10b

4.3.3.Click [OK] when the messagéou are opening a Legitronic Labeling Software for

b)

Windows 2.2.0 label format. If you save it, it will be upgraded t6.8.appears. (Figure 4-
11)

Legitronic Labeling Software 3.6.2
File Edit View Field Tools Window Help

_ID_IB_Iri_IFI EEIEEERE RN CNEEEEET T

2|5 |=| &|5|m|

Legitronic

1) ‘ou are opening a Legi for Windows 2.2.01 label format, TF yau sawe i, it will be: upgraded to .62

For Help, press F1

v

[ um |ové [

i I 4

Figure 4-11
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4.3.4.1f the printer that the label format is using is not fdupou will see the following

4-12)

egitronic Labeling Software 3.6.2
Edit WYiew Field Tools Window Help

D|es|&] 3] 24| 2] 22l s |ml@x] x| 2 [m]m] [O]E]2]2] (%]

Printer selection

The printer "Weber Zebra 170 Xil" is nesded to
convert this label but is not installed. Please select
a printer from the list of currently install=d printers
ta complete the label conversian.

Printers:
IM\crosoft Office Document Image Wwiiter LI

Refresh List
0K | Abon Label Conarsion |

~|
- i =
For Help, press F1 [ [ C UM ove | 2

Figure 4-12

4.3.5.Pull down the printer list and select your printerg(ffe 4-13)
NOTE: If your printer is not listed, review the Installing arfeer section of this document.

i Legitronic Labeling Software 3.6.2
File Edit WView Figld Tools ‘window Help

D[l |&] B o)) &) 22 b[%(@]x] x[2[m]m] |O]Ee]0] ][]

Printer selection : M=

The printer “wieber Zebra 170 %l is needed to
conwvert this label but is not installed. Please select
a printer fram the list of curently installed printers
to complete the label conversion.

Frinters:

“wéeber Zebra 140 X1l Plus

‘weber Sato B4605e Left
“weber Sato MEB400RY
‘weber Zebra 105501 203
‘weber Zebra 10551 300
‘weber Zebra 112 %l Flus
Weber Zebra 116 <illl Plus
A Pebra 140 Xilll Plus -
“Weber Zebra SO0l

“Weber Zebra PAx110 Right 203
“Weber Zebra PAX170 Right 203
Weber Zebra R170i 203
Weber Zebra R170i 300
WiehEw Document Loadsr

- i =
For Help, press FL [ | | |um ove 4

Figure 4-13

EX[EN

ll
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4.3.6.1f your label is using a database, you will see theailg: (Figure 4-14)

H" Legitronic Labeling Software 3.6.2
File Edit Yiew Figld Tools Window Help

For QalpJ |‘:ress F1 [ [ [ om W ’__j
Figure 4-14

4.3.7.Enter the DSN from Step 2.2%actly as you entered it in Step 2.22 and cli€k] . (Figure
4-15)

i Legitronic Labeling Software 3.6.2
File Edit ‘iew Field Tools Window Help

D|eer|d] &= 21| S| 2l slelelx] * 2w (o|E 2] 2] (|

Flease enter the data tource for "I TEMLIST"

ICumpanyLabeIS

o8|

= i =
For Help, press F1 [] [ | ow ove |

Figure 4-15
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4.3.8.Click the Save Icon when the label opens. (Figure 4-16)

Your label is now in 3.6 format. Review each field onhekabel and make any adjustments needed for
them all to look and function as intended, then savéatied.

\

Figure 4-16
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4.4.Using Tracking Serial Numbers in Label Formats

4.4.1.Right-click a field on the label and sel&=rial from the quick-pick men. Figure 4-17a) The
Field Propertiesdialog box opens with th&erial Numbergab activated. (Figure 4-17b)

Figure 4-17a Figure 4-17b
4.4.2.1n the Serial Number section, clickTracking.

4.4.3.From theTracking Serial Number Namedrop-down list, select the appropriate serial
number.

4.4.4.Click [OK].
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5. Appendix A, Migration Anomalies

When you are working with technologies that have suabng kpan of time between their respective
inceptions, you can expect that not everything will go dhlgoThis is just the nature of technology.
This section will address two situations that you maypanter.

5.1.Labels that will not open in Legitronic 3.6

5.1.1.0nly labels created in Legi for Windows 2.2.0 are able togened in Legitronic 3.6. You
may encounter labels that were created in earlieroreggihat ran fine in 2.2.0, but won't
open in 3.6. When these older labels were run in 2.2é), §imply ran, they did not
“become” 2.2.0 formats. If you try to open one of thesgitronic will tell you that it cannot
open them due to their version. There is nothing you cdn documvent this. These labels

will have to be redesigned.
5.2.Paradox databases that will not open in MS Access
5.2.1.0lder version of Legi for Windows used older versionPafadox to manage the databases.
These older version may not be recognized by currentoversif MS Access. As in the

above scenario, trying to open and save the tables inilRridt change anything. You will
need to go through an entirely different process.

5.2.2.0pen Legitronic for Windows 2.2 and clicRtabasg. (Figure 5-1)

Figure 5-1
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5.2.3.Click [Open). (Figure 5-2)

Figure 5-2
5.2.4.Browse toC:\legiwin\database(Figure 5-3)
5.2.5.Note that the.ist Files of Typeis set toDatabase tables(*.db)Figure 5-3)

5.2.6.Highlight the table you want and clickK]. (Figure 5-3)

Figure 5-3
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5.2.7.Note the field names. You'll need these later. (Figure 5-4)

5.2.8.Click [Export]. (Figure 5-4)

Figure 5-4

5.2.9.Click [Choose Destinatioip (Figure 5-5)

Figure 5-5
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5.2.10.Browse toC:\legiwin\database(Figure 5-6)
5.2.11.Note that the.ist Files of Typeis set toASCII files(*.csv). (Figure 5-6)
5.2.12.Give the table the same name as the original nangurg5-6)

5.2.13.Click [OK]. (Figure 5-6)

Figure 5-6

5.2.14.Click [OK]. (Figure 5-7)

Figure 5-7
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5.2.15.0pen the MS Access database you created earlier in tltiegsrand prepare to import the
table as before.

5.2.16.ChangeFiles of Typeto Text Files (*.txt, *.csv, *.tab, *.asc)(Figure 5-8)

5.2.17.Click [Import] .(Figure 5-8)

Figure 5-8
5.2.18.Choose th®elimitedoption, and then clickNext]. (Figure 5-9a)

5.2.19.ChooseCommaas the delimiter, and then clickipish]. (Figure 5-9b)

Figure 5-9a Figure 5-9b
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5.2.20.0pen the table and go into design view as you did in thegaju already imported.
(Figure 5-10a)

5.2.21.Change thd-ield Namesto match those in the original table, and change D&taTypes
to Text (Figure 5-10b)

5.2.22.Click [Savd and exit the table. (Figure 5-10b)

Figure 5-10a Figure 5-10b
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